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Summary. The numerical simulation of electric signal from the converter in the cyber-physical 

immunosensor system on rectangular lattice using differential equations with delay by means of R package is 

carried out in this paper. The functional features of R package as a programming environment for statistical data 

analysis are described, useful sites, references lists and documentation of R package are given. The names of 

parameters of the immunosensor model on rectangular lattice using the differential equations with delay and their 

numerical values in the package R are presented in the form of the table. The computer program «Numerical 

analysis of the electrical signal from the converter that characterizes the number of fluorescing pixels in the 

immunosensor on rectangular lattice using delayed differential equations» is implemented. The developed 

computer program makes it possible to carry out the investigation of the stability of immunosensory systems, which 

are widely used to obtain diagnostic information in order to evaluate critical states of cardiovascular disease, 

insulin values while measuring blood glucose values and identify quantitative indicators in some рharmaceutics 

compounds. The fragment of computer program listing in R package for obtaining the electrical signal from 

converter characterizing the number of fluorescent pixels in cyber-physical immunosensor system on rectangular 

lattice using delayed differential equations is presented. Numerical simulation for the electric signal from the 

converter in the immunosensor on rectangular lattice using the delayed differential equations is carried out. The 

changes of the received electrical signal corresponding to the number of fluorescent pixels in the cyber-physical 

immunosensory system are analyzed. The use of R package as a freely distributed software with graphical 

visualization of the analysis results is substantiated. 

Key words: cyber-physical system, biosensor, immunosensor, mathematical model, differential equation, 

R package. 
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Statement of the problem. Cyber-physical system (CPS) is physical system 

implementing integration of calculation and physical processes. They occur mostly in the form 

of built-in systems and networks for monitoring and control of physical processes with feedback 

systems. In such systems the dynamics of physical processes is the source of the investigated 

phenomenon information with the possibility of management and calculation of the object 

control signals [1]. 

The important stage of CPS design is the creation and investigation of the mathematical 

models properly reflecting the important, in terms of research tasks, aspects of special-time 
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immunosensor structure. The quality of immunosensor mathematical model significantly 

determines the efficiency of its processing methods and numerical simulation in CPS, defines 

the level of informative and representative values in diagnostic features and determines the 

structure of software and hardware components of immunosensor system. The investigation of 

their mathematical models stability using modern software is an important stage of CPS 

development.  

Analysis of available investigations results. Cyber-physical systems are identified 

with the manifestation of the fourth industrial revolution taking place in the modern world [2]. 

Thus, there is also the physical possibility to use «Internet of things» technologies where signals 

from sensors and measuring devices are needed. Therefore, there are more and more 

publications [3] in literature attracting attention to modern concepts and offering new 

innovative solutions. A. Platzer proposed the approach based on «dynamic logic» describing 

and analyzing cyber-physical systems [4]. Hybrid programs (HP) in simple programming 

language with simple semantics are used in these works. HP make it possible for programmer 

to refer directly to true terms of variables representing real values and determining their 

dynamics. 

Immunosensors are referred to analytical devices for qualitative and quantitative 

analysis of biological components of samples, based on the detection of specific antigens and 

antibodies by imminocomplexes. Based on detection mechanism nature, immunosensors can 

be divided into electrochemical, optical, piezoelectric, and others. Each type has its specific 

advantages and disadvantages resulting in the large number of investigations concerning the 

immunosensors development [5].  

It should be noted that the main component of all immunosensors is the receptor layer 

representing antigens, mono-polynocnal antibodies or their fragments in a certain way applied 

on transducer working surface. While looking for alternative antibodies the antidody fragments, 

aptamers and protein scaffolds of non-immunoglobulins are used [6–8]. Alternative molecules 

should meet certain requirements, i.e., their production should be fast and cheap, they should 

be stable under different conditions, and have long-term storage. In this case the antibodies 

«substitutes» should possess the required sensitivity and peculiarity [9]. The antibodies 

fragments with high peculiarities for their special analyte, ability to support antigens 

recognition, small sizes in comparison with full antibody are more applicable for 

immobilization than available naturally formed antibodies and turn be important tools in 

immunosensor investigation and development [10]. For bioreceptors immobilization in 

immunosensors the methods used in biosensors development are applied. 

Comparative analysis of electrochemical immunosensors with immobilized antibodies 

was carried out in for different ways (physical sorption, covalent binding using glutaric 

aldehyde, covalent binding using human IgG and protein A) is carried out in paper [11]. The 

carried out tests proved that the latest type of sensors with the possibility of their practical use 

has the best analytical characteristics [12].  

Objective of the paper is to carry out the numerical simulation of the electrical signal 

from converter in cyber-physical immunosensor system on rectangular lattice using differential 

equations with delay by means of R package.   

Statement of the problem. Due to the widespread use of immunosensors and the need 

to develop on their basis new immunosensor CPS it is necessary to perform computer 

simulation of the investigated models. Particularly during the numerical simulation of electrical 

signal from the converter on rectangular lattice using differential equation with delay by means 

of R package the environmental spatial-time device properties should be taken into account. 

Regarding spatial organization the investigated model is to be based on certain discrete structure 

taking into account immunosensor pixels interaction. That is why the numerical simulation of 
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electrical signal from converter in cyber-physical immunosensor system on rectangular lattice 

using differential equation with delay by means of R package is a problem. 

The results of the investigations. R package as the programming environment for 

statistical data analysis. Inspite of the programming languages variety used for CPS 

development (Assembly, C, C++, D, Java, JavaScript, Python, Ada and others) R language is 

nowadays widely used in many branches involved in data machine learning and visualization. 

R package is the programming environment for statistical data analysis consisting of basic R 

program acting as interpreter of statistical S programming language and individual packages 

implementing special methods and technologies for statistical data processing. R program is 

non-commercial and is freely distributed providing that GNU General Public License 

requirements are hold [13].  

Програма R є некомерційною і вільно розповсюджується за умови дотримання 

вимог GNU General Public License [13]. This program is also used as the alternative to 

commercial programming environments of data processing of MatLab / Octave level. On the 

other hand, it is quite natural that the basic computing power R is mostly manifested in 

statistical analysis: from calculations of averages to wavelet-transformations of time series. 

The additional R popularity is the creation of storage and distribution packages CRAN 

(Comprehensive R Archive Network – http://cran.r-project.org) [14]. Statistical algorithms are 

usually performed in the form of scripts and complied into R packages. During installation 

along with the basic program the main packages are also installed. These packages implement 

the most popular methods of statistical analysis. Some of thee packages are automatically 

downloaded at R start-up. The others can be downloaded using library function.  

Advantages of R package: 

• R package is free software; 

• there are implementations for Microsoft Windows, Mac OS X, Linux operating 

systems; 

• basic R set occupies little space on the disk and contains all functions necessary for 

statistical analysis; 

• you can always install additional packages; 

• good graphical data presentation and tier results analysis; 

• ability to enter necessary functions independently. 

Development with R package 

After opening R x64 3.5.2 package the main page of the program appears (Fig. 1) 
 

 
 

Figure 1. The main window of R x64 3.5.2 package program 
 

While working with R you can perform simultaneously many instructions recorded in 

separate file. In order to do this it is necessary to download the corresponding file in any word 

editor, copy and then paste into the program. In this case, if the instructions in the file are located 

in separate lines, then no punctuation between them is required. In the base program you can 

open the editor window or download the file with script for new script creation using File-

>Newscript або File->Openscript options in the main menu. You can completely perform the 

downloaded script in the editor window using Edit->Runall. 

Having completed with the script it can be stored using File->Save. 
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Useful sites, references and documentation on R package: 

 http://www.r-project.org/ – project site; 

 http://cran.r-project.org/ – CRAN; 

 https://stat.ethz.ch/pipermail/r-help/ – references R-help; 

 http://finzi.psych.upenn.edu/nmz.html – material search on R; 

 http://www.statmethods.net/index.html – R package reference resource; 

 http://zoonek2.free.fr/UNIX/48_R/all.html – R package guide; 

 http://pj.freefaculty.org/R/Rtips.html – tips for R package use.  

The results of numerical simulation of electrical signal from converter of cyber-

physical immunosensor system. In order to obtain the results of numerical simulation of 

electrical signal from converter characterizing the number of fluorescent pixels in cyber-

physical immunosensor system on rectangular lattice using the differential equation with delay 

parameters implementation of immunosensor model, their numerical values and parameters 

representation and their numerical values in R package are important according to Table 1.  
 

Table 1 
 

Values of immunosensor model parameters on rectangular lattice using differential equations with delay 

 

Sequence 

number 
Name of the model parameter 

Numerical 

parameters values 

Representation 

of parameters 

and their 

numerical values 

in R package 

1 2 3 4 

1 

Natyral integer characterizing the 

immunopixels number in rectangular 

lattice 

4N  
N <- 16#4#16 

 

2 
Birth-rate constant for antigen 

population 
1

min2


  beta <- 2 

3 
Probable rate of neutralization of 

antigens by antibodies g

mL




min
2  gamma <- 2 

4 Antibody death-rate constant 
1

min1



f

  mu_f <- 1 

5 Antigens density  /8.0  
etha <- 

0.8/gamma 

#0.01184/gamma 

6 

The rate at which the antigens 

population tends to reach some 

saturation limit 
g

mL




min
5.0  delta_v <- 0.5 

#0.035 #0.7 

7 

The rate at which the antibody 

population tends to reach some 

saturation level g

mL
f







min
5.0  

delta_f <- 0.5 

#0.0175 #0.2 

8 
Constant of delay in time at which the 

immune response occur 

0.05 , 

0.22 , 

0.23  

0.2865  

tau <- 

0.05#0.22#0.23#

0.2865 

9 Diffusion coefficient 
min

2.0
2

nm
D   D <- 0.2 

10 Distance between pixels nm3.0  Delta <- 0.3 
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To be continued table 1 

1 2 3 4 

11 Imbalance constant 0n  n <- 0.9 #1. 

12 

Fluorescent intensity ratio to the 

number of contacts between antigens 

and antibodies 
flk  k_fl <- 1 

13 

Threshold limit value determining 

transition to the fluorescent state in 

biopixels 
fl  

fluorescence_int

ensity_threshold 

<- 1.5 

 

After introduction of the appropriate values of immunosensor model parameters on 

rectangular lattice using differential equations with delay according to Table 1, the 

representation in R x64 3.5.2 package is as following in Figure 2.  
 

 
 

Figure 2. Representation in R x64 3.5.2 package of the immunosensor mathematical model on rectangular lattice 

using differential equations with delay and corresponding parameters, according to Table 1 

 

The result of immunosensor mathematical model introduction on rectangular lattice 

using differential equation is shown in Figure 2 in the following way 

 

 
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)())()((
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,
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,

tFtFtV
dt

tdF

VStVtVtF
dt

tdV

jijifjif
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ji
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




 (1) 

 

The ames of immunosensor model parameters (1) are given in Table 1. The detailed 

description of the investigated immunosensor mathematical model on rectangular lattice using 

differential equations with delay are presented in papers [16–18].  
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Listing segment of computer program for obtaining the electrical signal from 
converter  

  #------------------------------------ 
  # plotting "signal" 
  #------------------------------------ 
  dev.new() 
  p <- ggplot(data=fluorescence_sum, aes(x=time, y=fluorescence_tile_sum)) + 

ylab("fluorescencing pixels") + 
    geom_line(color="blue") +  
    geom_point() 
  print(p) 
  dev.off() 
dir.create(file.path(paste("D:/My_doc/Sverstiuk/Biosensors/Imunosensory/Plots6_Cyb

erPhysical/", paste("Tau",tau,sep=""),sep=""),"fluorescence_matrix"), showWarnings = 
FALSE) 

setwd(file.path(paste("D:/My_doc/Sverstiuk/Biosensors/Imunosensory/Plots6_CyberP
hysical/", paste("Tau",tau,sep=""),sep=""),"fluorescence_matrix")) 

  png(paste(paste("Tau",tau,"time",time,"signal",sep=""),"png",sep="."), width = 800, 
height = 600) 

  print(p) 
  dev.off() 
}# end of program 
Results of numerical analysis of electrical signal from converter of cyber-physical 

immunosensor system. At the given stage of computer simulation of cyber-physical 
immunosensor system the electrical signal from converter characterizing the number of 

fluorescent pixels at 05.0 , 22.0 , 23.0 , 2865.0  is obtained and shown in 
Fig. 3 (a–d).  

 

  
а b 

  
c d 

Figure 3. The ctrical signal from converter haracterizing the number of fluorescent pixels at 05.0  (а), 

22.0  (b), 23  (c), 2865.0  (d) 
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According to Fig. 3 (a–d) we observe that if  value changes, the qualitative pixels and 

the whole immunosensor behaviour changes as well. For example, at ]22.0,0[  we see the 

trajectory corresponding to the stable node for all pixels (Fig. 3(a,d)).  

At values   approximate to min23.0  Hopf bifurcation occurs and further trajectories 

correspond to the stable boundary cycles of ellipsoid shape for all pixels (Fig. 3 (c) for 

23.0 ). For values 27.0  we observe chaotic behaviour (Fig. 3 (d)). The experimental 

confirmation of the level of electrical signal from converter as characteristics of fluorescent 

pixels number at 05.0 , 22.0 , 23 , 2865.0  is carried out.  

Conclusion. Computer simulation of electrical signal from converter of cyber-physical 

immunosensor system on rectangular lattice using differential equations with delay by means 

of R package is carried out. The obtained results are of essential importance in the investigations 

of immunosensor model stability. This takes into account the availability of antigens and 

antibodies colonies localized in pixels, antigens colonies diffusion between pixels and other 

paremeters according to Table 1.  
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Резюме. Проведено чисельне моделювання електричного сигналу з перетворювача в кіберфізичній 

імуносенсорній системі на прямокутній решітці з використанням диференціальних рівнянь із запізненням 

за допомогою пакета R. Описано функціональні можливості пакета R як середовища програмування для 

статистичного аналізу даних, наведено корисні сайти, списки посилань і документація пакета R. У 

вигляді таблиці представлено назви параметрів моделі імуносенсора на прямокутній решітці з 

використанням диференціальних рівнянь із запізненням та їх числові значення в пакеті R. Реалізовано 

комп’ютерну програму «Чисельний аналіз електричного сигналу з перетворювача, який характеризує 

кількість флуоресціюючих пікселів в імуносенсорі на прямокутній решітці з використанням 

диференціальних рівнянь із запізненням». Розроблена комп’ютерна програма дає змогу провести 

дослідження стійкості імуносенсорних систем, які широко використовуються для отримання 

діагностичної інформації з метою оцінювання критичних станів при серцево-судинних захворюваннях, 

величини інсуліну при вимірюванні величини глюкози в крові та виявлення кількісних показників у деяких 

фармацевтичних сполуках. Наведено фрагмент лістингу комп’ютерної програми в пакеті R для 

отримання електричного сигналу з перетворювача, який характеризує кількість флуоресціюючих пікселів 

у кіберфізичній імуносенсорній системі на прямокутній решітці з використанням диференціальних 

рівнянь із запізненням. Проведено чисельне моделювання для електричного сигналу з перетворювача в 

імуносенсорі на прямокутній решітці з використанням диференціальних рівнянь із запізненням. 

Проаналізовано зміни отриманого електричного сигналу, які відповідають кількості флуоресціюючих 

пікселів у кіберфізичній імуносенсорній системі. Обгрунтовано використання пакета R як 

вільнопоширюваного програмного забезпечення з графічною візуалізацією результатів аналізу 

Ключові слова: кіберфізична система, біосенсор, імуносенсор, математична модель, 

диференціальні рівняння, пакет R. 
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